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FOREWORD

Since its establishment in 1976, Acharya Nagarjuna University has been forging ahead
in the path of progress and dynamism, offering a variety of courses and research
contributions. 1 am extremely happy that by gaining a B++ (80-85) grade from the
NAAC in the year 2003, the Acharya Nagarjuna University is offering educational
opportunities at the UG, PG levels apart from research degrees to students from over
285 affiliated colleges spread over the three districts of Guntur, Krishna and
Prakasam.

The University has also started the Centre for Distance Education with the aim
to bring higher education within reach of all. The centre will be a great help to those
who cannot join in colleges, those who cannot afford the exorbitant fees as regular
students, and even housewives desirous of pursuing higher studies. With the goal of
brining education to the doorstep of all such people, Acharya Nagarjuna University
has started offering B.A., and B.Com courses at the Degree level and M.A., M.Com.,
M.Sc., M.B.A., and L.L.M., courses at the PG level from the academic year 2003-2004
onwards.

To facilitate easier understanding by students studying through the distance
mode, these self-instruction materials have been prepared by eminent and experienced
teachers. The lessons have been drafted with great care and expertise in the stipulated
time by these teachers. Constructive ideas and scholarly suggestions are welcome from
students and teachers involved respectively. Such ideas will be incorporated for the
greater efficacy of this distance mode of education. For clarification of doubts and
feedback, weekly classes and contact classes will be arranged at the UG and PG levels
respectively.

It is my aim that students getting higher education through the centre for
Distance Education should improve their qualification, have better employment
opportunities and in turn facilitate the country’s progress. It is my fond desire that in
the years to come, the Centre for Distance Education will go from strength to strength
in the form of new courses and by catering to larger number of people. My
congratulations to all the Directors, Academic Coordinators, Editors and Lesson-
writers of the Centre who have helped in these endeavors.

Prof. P. Raja Sekhar

Vice-Chancellor
Acharya Nagarjuna University
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OBJECTIVES:

At the end of this Practical lab, student should be able to
e Understand basic concepts and terminology of information technology.
e Have a basic understanding of personal computers and their operations.
e The students would acquire the MS-Word related skills which would enable them to do
several essential activities which are a part of their Business Management curriculum like
CV Writing, summer training report writing etc. Students will acquire the knowledge in
Data analysis using Excel, Power Point Presentation styles

Computer Basics

. Identifying different parts of Computer.

. Identifying different input and output devices.

. Installing a software (for example ms word, antivirus) using license key.
. Identifying different desktop icons and it” s working.

A~ WD

MS WORD

. Creation of documents letters invitations etc,
. Creating your personal resume.

. Creating your class timetable.

. Perform mail merge using MS Word

A WDN B

MS EXCEL

1. MS Excel performing different formulas

2. Creating charts in Excel.

3. Printing and adjusting MS Excel worksheet

4. Prepare a worksheet for calculating percentages of your class mates using different excel
formulas.

MS Power Point.

1. Create presentation in power point
2. Inserting, deleting slides in Power Point
3. lllustrate Animation in presentation
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OBJECTIVES:

The objective of this lab is to master the basics of Microsoft Excel, PowerPoint, and Word
and to learn how to employ these applications. These programs are widely used in Real time
environment so proficiency in these applications is a requirement. The student can understand
the basics of a computer system and use of MS-office tools.

STRUCTURE:

1. COMPUTER BASICS

1.1  Identifying different parts of Computer.
1.2 Identifying different input and output devices.
1.3 Installing a software (for example ms word, antivirus) using license key.
1.4 Identifying different desktop icons and it.s working.
2. MSWORD
2.1  Creation of documents letters invitations etc,
2.2 Creating your personal resume.
2.3 Creating your class timetable.
2.4 Perform mail merge using MS Word

3. MS EXCEL

3.1
3.2
3.3
3.4

MS Excel performing different formulas

Creating charts in Excel.

Printing and adjusting MS Excel worksheet

Prepare a worksheet for calculating percentages of your class mates using

different excel formulas.

4. MS POWER POINT

4.1
4.2
4.3

Create presentation in power point
Inserting, deleting slides in Power Point

[llustrate Animation in presentation
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1. Computer Basics

1.1 Identifying different parts of Computer.

1. Cabinet: Itis used to install all hardware devices like (mother board,
SMPS, HDD, CD Rom, and FDD). It has Start, Restart Button, LEDs, Audio
and USB Connecters are available at front side.

2 System board/Motherboard

This is the major part of the PC hardware. It manages all
transactions of data between CPU peripherals. It holds
the Processor, Random Access Memory and other parts,
& has slots for expansion cards. It is rectangle shape.

3. Socket 478:

Socket 478
()

CPU

It use 478 — PIN MICROPGA package it is used installing CPU It is square _
type design. sinkand 3

Retention

4 CPU

The central processing unit contains the heart of any computer, the
processor. The processor is fitted on to a Mother Board. The Mother Board
contains various components, which support the functioning of a PC. It is
brain of the computer. It is square shape
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5 RAM Slots:

RAM slots are used to install the RAMs. It is large rectangle shape and each ending has small clips.
There two type ram slots

SD RAM: Two Gaps (synchronous DRAM) is a generic name for various kinds of dynamic Random
access memory (DRAM) that are synchronized with the clock speed that the microprocessor is
optimized for. This tends to increase the number of instructions that the processor can performin a
given time.

S5 2 = T o

EREENNANGANARAND YERERARNAEANSNEANGRNNS ( | SOSSEANESANNEDUARIRUREONONINAS RARREEIANL

DDR RAM: One Gap (Double Data Rate Synchronous DRAM: A clock is used to read data from a
DRAM. DDR memory reads data on both the rising and falling edge of the clock, achieving a faster
data rate.)

DDR RAM & SD RAM Silots

5 0

N3dO I5\5°1)
L]

6 CMOS Battery:

Computer is using a coin shape battery. It generates the clock
signal and it manage system continues time.

7. Primary & Secondary (IDE-1 & IDE-2):

It is also called as IDE-1, IDE-2. It used to connecting Hard Disk Drive, CD ROM, DVD ROM.
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8. Input & Output ports:

10 ports are used to connecting |0 device such as key boards, mouse, monitor, printer, scanner,
speakers etc...

it 1 -

Op:icu‘l Uss A Firewire Fir-wlre Firewire Ethemet
1.err 2z 0 4 pin 200

RJ ~21 Ooakcop S-rla’l
“‘l’osltnk' Alink 13900 1384b/c w’” e
« - ----
DE-9F DE-25 Serial/Com Port DE-’ Sol‘ial

! Centrontcs Parallel 36pin Centronics SCSI S@pin

SR Ly S e Surround sournd

: 3 P 5 — -~
|m s
AAUT

Compos=site Audios/Video S-video

Mac ni

Mi - .
ZQOmApOrt/ MITS DA DizplayPort Mini-DVI Mini

DMSS9 (dual DVI-D)

!
|

Parallel Port/SCSY 1/DB-25F

s

DVI video B

9. BIOS Chip:

BIOS controls how the operating system and hardware work
together. BIOS identification is BIOS name is available on chip or
mother board




Information Technology 5 Practical Manual

10. Bus Cables or Data cables:

A Bus is a collection of wires through which data is transmitted from one device to another device

cables are two types
IDE cable: it used to connect HDD, CD ROM, and DVD ROM

FDD cable: it used to connect FDD (braking or manufacture defecting)

FDD Cable

IDE Cable

11. SMPS:

SMPS is used to supply the power to Mother Board HDD,
CD ROM, and FDD. In SMPS holds a transformer, voltage
control and fan. Identification is the rectangular box
shape and panel name is switching mode power supply.
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1.2 Identifying different input and output devices.

Monitor:

Monitor of a computer is like a television screen. It displays text
characters and graphics in colors or in shades of grey. The monitor is also
called as screen or display or CRT (cathode ray tube). In the monitor the
screen will be displayed in pixels format. Such as 800 by 600 pixels, 1024
by 768 pixels etc.

Key Board:

Key board is like a type writer, which contains keys to
feed the data or information into the computer
Keyboards are available in two modules. These are
standard key board with 83-88 keys and Enhanced
key board with 104 keys or above

Mouse:

a. Every mouse has one primary button (left button) and one
secondary button (right button). The primary button is used to
carry out most tasks, whereas secondary button is used in special
cases you can select commands and options

Printer:

A device that prints images (numbers, alphabets, graphs, etc...) on paper is known as Printer. We
have different types of printers to take printouts.

These are as follows:
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Dot matrix printer Inkjet printer

Laser printer

Speakers:

Speakers make your system much more delightful to use entertain you
while you are working on computer

Scanner:

Scanner used to scan images and text
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1.3 Install Windows 7

Recommended Equipment
The following equipment is required for this exercise:
¢ A computer with a blank hard disk drive.

¢ Windows 7 installation DVD or USB flash drive.

Step 1

Insert the Windows 7 installation DVD into the DVD-ROM drive or plug the USB flash drive into a USB
port.

When the system starts up, watch for the message “Press any key to boot from CD or DVD.”

If the message appears, press any key on the keyboard to boot the system from the DVD. If the press
any key message does not appear, the computer automatically starts loading files from the DVD.

Fress any key to boot from CD or DUD._

The computer starts loading files from the DVD or USB flash drive.
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windows is loading files...

Step 2

The “Windows 7 boot” screen appears.

Starting Windows

Step 3
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The “Install Windows” window opens. Press Next unless you need to change the default settings.

mmwmaons i

.
Windows 7

Language to install: g
Time and currency format: English (United States) X

Keyboard or input method: [

Enter your language and other preferences and click "Next

Copyright © 2003 Microsoft Corporation. All rights reserved.

Step 4

Press Install now to continue.

% Install Windows )

-
Windows 7

g C
Install now -3

What to know before installing Windows

Repair your computer

Copyright € 2003 Microsoft Corporation. All rights reserved.

Step 5
The Collecting information section of the installation begins.

The “Setup is starting...” screen appears.
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Setup is starting...

Next the “Please read the license terms” screen appears. Read and confirm that you accept the
license by selecting the box “I accept the license terms”. Click Next.

Please read the license terms

MICROSOFT SOFTWARE LICENSE TERMS
WINDOWS 7 PROFESSIONAL
These license terms are an agreement between you and
the computer manufacturer that distributes the software with the computer, or
the software installer that distributes the software with the computer.
Please read them. They apply to the software named above, which includes the media on
which you received it, if any. Printed-paper license terms, which may come with the

software take the place of any on-screen license terms. These terms also apply to any
Microsoft

updates,

1 Collecting information 2 Installing Windows

Step 6

The “Which type of installation do you want?” screen appears. Click Custom (advanced).



Centre for Distance Education 12 Acharya Nagarjuna University

Which type of installation do you want?

Upgrade

Upgrade to a newer version of Windows and keep your files, settings, and programs.
The option to upgrade is only available when an existing version of Windows is
running. We recommend backing up your files before you proceed.

Custom (advanced)
Install a new copy of Windows, This does not keep your files, se
pregrams. The option to m gest d partitions is

Help me decide

1 Collecting information 2 Installing Windows

Step 7

The “Where do you want to install Windows?” screen appears. Select the hard drive or partition on
which Windows 7 will be installed.

Click Next to select “Disk 0 Unallocated Space”, which is the default setting.

Where do you want to install Windows?

| Name Total Size Free Spacel Type

= Disk 0 Unallocated Space 300 GB 30.0 GB

44 Refresh Drive options (advanced)

&9 Load Driver

Collecting information 2 Installing Windows
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The Collecting information section of the installation ends.

Step 8
The Installing Windows section begins.

The “Installing Windows...” screen appears. Windows 7 Setup may take up to 50 minutes to
configure your computer.

Installing Windows...

That's all the information we need right now. Your computer will restart several times during
installation.

J Copying Windows files
Expanding Windows files (2%) ..
Installing features
Installing updates
Completing installation

1 Collecting information 2 Installing Windows

Step 9

The “Windows needs to restart to continue” screen appears. Your computer will automatically
restart or you can click Restart now.
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27 Install Wmdoinsx ‘T _ﬂi \

Windows needs to restart to continue

I

Restarting in 6 seconds

1 Collecting information 2 Installing Windows

If you get the message “Press any key to boot from CD or DVD.”, do not press any key and Windows
will boot from the hard disk to continue the installation.

Press any key to boot from CD or DUD._

Step 10

The “Setup is updating registry settings” message appears.
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Setup is updating registry settings

Step 11

The “Setup is starting services” message appears.

Setup is starting services

Step 12
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The “Installing Windows...” screen appears again. Windows may reboot a few more times. This may
take several minutes.

Installing Windows...

That's all the information we need right now. Your computer will restart seversl times during
installation.

1 Collecting information 2 Installing Windows

The Installing Windows section of the installation is completed.

Step 13
The “Set Up Windows” section begins.

Type the user name and computer name provided by your instructor. Click Next.

Q 4 SetUp Windows

£7 Windows 7 Professional

Choose a user name for your sccount and name your computer te distinguish it on the network.

Type a user name (for example, John):
Vicki M

Type a computer name:
VickiM-PC

Copyright © 2009 Microsoft Corporation. All rights reserved.

Step 14
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The “Set a password for your account” screen appears. Type the password provided by your
instructor.

Retype the password and enter the password hint. Click Next.

@ 4 SetUp Windows

Set a password for your account

Creating a password is a smart security precaution that helps protect your user account from
unwanted users, Be sure to remember your password or keep it in a safe place.

Type a password (recommended}:

Retype your password:

Type a password hint (required):

My faverite car

Choose a word or phrase that helps you remember your password.
If you forget your password, Windows will show you your hint.

Step 15

The “Type your Windows product key” screen appears. On this page, type your product key as it
appears on your Windows 7 DVD case. Click Next.

K3 4 SetUp Windows

Type your Windows product key

You can find your Windows product key on a label included with the package that came with
your copy of Windows. The label might also be on your computer case. Activation pairs your
product key with your computer.

The product key looks similar to this:
PRODUCT KEY: X300 - XXX - KOO - XXX - XXXHX

ABCDE-FGHIJ-KLMNO-PQRST-UVWXY
(dashes will be added automatically)

[¥] Automatically activate Windows when I'm online

What is activation?
Read our privacy statement
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Note: If you entered your product key, Setup will not ask you the following:

“Do you want to enter your product key now?” screen appears. If you were instructed not to enter a
product key, click No.

Step 16

On the “Help protect your computer and improve Windows automatically” screen, click Use
recommended settings.

@ 4 SetUp Windows

Help protect your computer and improve Windows automatically

Use recommended settings

A
@ Install impertant and recommended updates, help make Internet browsing safer, check

[}cnlinefcr soluticns to problems, and help Microsoft improve Windows.

|@ Install important updates only

Cnly install security updates and other impertant updates for Windows.

[@ Ask me later

Until you decide, your computer might be vulnerable to security threats.

Learn more about each option

When you use recommended settings or install updates only, some informaticn is sent to
Microsoft. The information is not used to identify you or contact you. To turn off these settings
later, search for 'Turn off recommended setting' in Help and Suppoert. Read the privacy statement

Step 17

On the “Review your time and date settings” screen, configure the computer clock to match your
local date, time, and time zone. Click Next.
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@ o SetUp Windows

Review your time and date settings

Time zone:

[(UTC-OS:OO) Pacific Time (US & Canada) v

Autematically adjust cleck for Daylight Saving Time

Date: Time:

November, 2010

Mo Tu We Th Fr
31 1 2 38 5 6
7.8 9010 111213
14 15 16 17 18 19 20
2102 23 24 25 26 27
282030 1 2 3 4
6 7 8 9 10 11

Step 18

The “Select your computer’s current location” screen appears. Select the option provided by your
instructor

Note: This screen will not show up if the installation did not correctly install drivers for the network
card.

@ o4 SetUp Windows

Select your computer’s current location

This computer is connected to a network. Windows will automatically apply the correct network
settings based on the network's location.

/‘ Home network

I:ly If all the computers on this network are at your home, and you recognize them, thisis a
trusted home network. Don't choose this for public places such as coffee shops or

airports.

i Work network
If all the computers on this network are at your workplace, and you recognize them, this
is a trusted work network. Don't choose this for public places such as coffee shops or
airports.

Public network

If you don't recognize all the computers on the netwerk (for example, you're in a coffee
shop or airpert, or you have mobile broadband), this is a public network and is not
trusted.

If you aren't sure, select Public network.

Step 19
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The “Windows is finalizing your settings” screen appears.

@ A Set Up Windows

£7 Windows 7 Professional

Windows is finalizing your settings

The “Set Up Windows” section is completed.

Step 20

The “Welcome” message appears.

T Welcome

Step 21

The “Preparing your desktop...” message appears.
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O Preparing your desktop...

. Windows 7 Professional

Step 22

You are logged in to Windows 7 for the first time.

‘\; >
-
Recycle Bin

12100M | |
11/4/2010 |

~ e




| Centre for Distance Education

22

Acharya Nagarjuna University

1.4 Identifying different desktop icons and its working.

The Windows desktop contains a range of icons, some of which appear when you install Windows 7,
and some that appear when you install new programs. Icons with an arrow are known as shortcuts
or links to programs, files or folders. You can double-click on a desktop icon to launch that program,

folder or file.

Programs - Icons

The icons to the left represent shortcuts to various programs. You can tell it’s a shortcut as it
contains an arrow. So, if you were to delete the shortcut, you wouldn’t be deleting the actual

program, only the desktop link to it.

Double-clicking on the relevant icon will launch that program. For example, if you double-click on the

icons to the left you will launch:

1. Microsoft Word 2007 (word processing
program)

2. Google Chrome (internet browser)

Type: Microsoft Word Document
Authors: KSSR

Size: 241 KB

Date modified: 7/15/2021 9:37 PM

Google Chrome

3. Adobe Acrobat Document (to view PDF files)

Type: Adobe Acrobat Document
Size: 148 KB
Date modified: 6/30/2021 10:27 AM
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Files - Icons

Icons that show a page represent a file. When you double-click on the icon, the file will open in the
program that it was created in. The picture to the left shows that the file was created in Notepad.
However, as no arrow appears, it is not a shortcut, but indicates that this file was actually saved to
the desktop. Therefore, if this desktop icon is deleted, so is the actual file.

Gryaiclass

|d e
[tern type: PNG image
Dimensions 1330 x 348
Size: 429 KB

Type: Text Document
Size: 35 bytes
Date medified: 7/16/2021 2:52 PM

Folders and drives

Icons that show a folder represent a folder or shortcut to a folder. When you double-click on a folder
icon, the Windows Explorer window will open and you will see the contents of that folder. Similarly,
icons that show a hard disk will display the contents of that drive in Windows Explorer when you
double-click on it.

Shows the disk drives and hardware connected to this computer.

Mafsre

Date created: 4/1/2021 1:23 PM
Size: 3.05 GB
Files: ...

Recycle Bin

The desktop icon for the Recycle Bin is shown as a waste paper basket with the recycle symbol on it.
Double-clicking on this icon will open the Recycle Bin window, allowing you to permanently delete or
restore files as necessary.

| Contains the files and folders that you have deleted.
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2. MSWORD

2.1 Creation of documents letters invitations etc.

Create a letter head of a company

i. Name of Company on the top of the page with big font and good style

ii. Phone numbers, fax numbers, e-mail address with appropriate symbols
iii. Main products manufactured to be described at the bottom

iv. Slogans if any should be specified in bold at the bottom

1. From the Insert command tab, in the Header & Footer section, click Header or Footer. The scroll
list of preset headers or footers appears.

This will open what looks like a textbox.

...................................................................

InsertAuoText- |9 @) #F |8 © |1 & | | E S 5, | dese

The Header and Footer toolbar pops up when we are working in this layer.

2. From the Insert command tab, in the lllustrations section, click Picture. The Insert Picture dialog
box appears. And then select the image.

3. Click on the logo, grab one of the corner handles and drag in the size to get what we need.
Be sure to grab a corner handle or you can easily warp the image.

4. To set logo along the right margin quickly click on it and hit Ctrl + R,



Information Technology 25 Practical Manual

2l Document 1, - Microsoft Word

omat  Tools Table iMindow Help Type a question for help

UNIPATEH |
IRUBBER LIMITED

Header and Fook

al= @ ¢
Page 1 Sec 1 REC| [TRK| EXT | OwR| | B Item collect:

5. To adjust indent position, hit Ctrl + A to select all and then drag indent marker...that will be
displayed along the ruler.

ocument1 - Microsoft Word

Help Type 3 question for

Pags 1 Sec 1 171 AtO8 L Col L REC| [TRK] [ExT | [ovr]| [ B

6. Type the company address line by line.
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Type 3 auestion for help |+

UNIPATCH:

RUBBER LIMITEDE

Plot No. 9, KIADB

Industrial Area, Hoskote,
Bangalore — 562114

Ph: 080 — 27971584 |
E-mail: unipatchbna@usnl net |

|88 FEe a2 E T8, e

& unttled - Paint

7. To jump to the footer by clicking on the Switch icon on the Header and Footer toolbar, as
shown below. Or just click within the footer area.

Switch Between Header and Footer

8. Select the line tool. Click in the footer layer and hold the mouse button in as we drag the cursor
to create the desired line. Release the mouse button when we are finished and the line will appear.

& Document1 - Microsoft Word

Insert Format Tools Table Window Help

Header and Footer

Insert AutoText - I I s ez e e

Footer
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9. Press “center” alignment button in the format toolbar and type the slogan of the company.

1§ Document1 - Microsoft Word

Format  Tools  Table tindow Type a question for help = X

=
~

[Header and Footer

Ingert utoText - EEEEEEE T EEE

f gy R R T 7d0PM

10. After we have the header/footer setup the way we need, click the Close icon on the
Header/Footer toolbar.

Header and Footer

Insert AutaText =

lose Header and Fooker

11. This will close this layer and we'll return to the upper document layer.

) Document1 - Microsoft Word

Format  Tools Table Widow Help
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2.2 Creating your personal resume.

1. Open a blank word document.
2. Go to the “Layout” tab and click the “Margins” buttons.

File Home Insert Draw Design References

'::: Ereaks = j
£ Line Numbers =

Genko
fiegizr= = = - - bE Hyphenation ~ Setting

Page Setup ' Genko

3. The drop-down menu displays several different margin options from which to choose. If you
can’t find the one you’re looking for, you can click “Custom Margins” at the bottom and
enter your specifications

Normal
Top: 1" Bottom: 1"
Left: 1" Right: 1"

Narrow
Top: 05" Bottom: 0.5"
Left: 0.5" Right: 0.5"
Moderate
Top: 1 Bottom: 1"
Left 075" Right: 0.75"
Wide
Top: 1" Bottom: 1"
Left: 2" Right: 2"
Mirrored

m Top: 1" Bottom: 1"
Inside:  1.25" Outside: 1"

Office 2003 Default
Top: 1" Bottom: 1"
Left 125" Right: 1.25"

' Custom Margins... I

4. Click “OK” once you’ve entered the margin sizes you want.

Margins ‘ Paper | Layout | Document Grid ‘

. 1 S Bottom: 1 z
] 0.63" S| Right 63" S
F TR R T T —

Orientation

Portrait Landscape
Pages

Multiple pages: Normal

Preview

Applyto: | Whole document |E|
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10.
11.

12.
13.

14.
15.
16.

17.
18.

go to insert table and take one cell then type CHRRICLILLINM NITAE Highlight it

] . Times Mew Rom - 12
and];ﬂlect times new roman and increase font

on and bold it from FONT group.

Press ENTER key twice to give space and press TAB key from keyboard to add
another cell or row.

Now type PERSONAL INFORMATION, highlight it and right click on it. Select
Times New roman and font size 12.

now highlight this row, select shading from table styles and select background color

size by click

CURRICULUM VITAE

PERSONAL INFORMATION

Full Name TRada Rohit Arva

Press tab key on your keyboard to add another cell. Leave it blank.

Now press tab key again to add new cell.

Here we want to columns in this row. So right click and select split cell. It splits cell
to two columns.

CURRICULUM VITAFE

PERSONAL INFORMATION

in first columns type "Full Name: " and in second column type "Rohit Arya"

Press tab key again to add new row. Now row with two columns is added. Enter
Gender and Male in respective columns.

Add 2 more rows to provide personal information in resume.

Now again press tab key to add new row. it adds a new row with two columns

Select those two columns. Right click on it. Select merge cell to make them as a
single column or cell.

7 =)

P e o B T I L I TS
Address S1. Patamata. Vijavawada.
Times Ne A n ==

s NewRom - 12+

rzwoA-a-E

Now type CAREER OBJECTIVE.
now highlight this row, select shading from table styles and select background color
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19.
20.
21,
22,

23.
24,
25.
26.

27,
28.
29.

30.

31.
32.
33.

Now again press tab key to add new row and type objective of your resume.

Now press tab key to add new row.

Now again press tab key to add new row.

Type EDUCATIONAL BACKGROUND. highlight the row, select shading from
table styles and select background color which one

You selected before.

Now type your education information line by line.

Press TAB key twice to add two rows.

type WORK EXPERIENCE highlight the row, select shading from table styles and
select background color which one you selected before.

type your job experience information line by line.

press TAB key twice to add two rows.

type KEY ACHIEVEMENTS highlight the row, select shading from table styles and
select background color which one you selected before.

now type your skills required for the job line by line. Our Resume will looks like this

CURRICULUM VITAE
| FERSOR AL TRFORMATION
Full Name Boda Fohif Ana
| Gender TEE
Thonz TOEETTRE S
Email boda arva X @ emailoam
| Addr=s: T, Paramana, Vjayavad

| CAFEER OBJECTIVE
To mzke 2 sound position i corporzteword and work towasds 11 0y PuraKng profess:
skills and kmowledss with devotion and hard work

| EDUCATIORAL BACEGROUND
B.C0OM - Bachelor of Commere fromP R Collez= Ealmads Andhe Tnfversity

ME.A (Master of Business Admimistration) from Pondichersy University, Pandicherry with
specizlization of Marksting

| WORE EXFERIENCE
Worked asa CF Traines m Azshes InfoT=ch Limited Listad m BEE, NEE, TTEE from Naw
Drelhi (02011 mJzn2012)
Worked 253 C3 Traines in Saryendrs Sherms &Associzms one of the ledins PCE in Agra
(Tune 2012t Feb 2013)

| SEILLS

| Paticipared :nmn’.p;]ﬂlmeammnum (NIZEL
Bmart working, ability to gzt along well with peopls
Good analytical Skill and positive attituds.

after entering all the details in table format, remove the border line
select the entire table by double click on it.
select borders from borders group.

34. select no border option from the top down list.

35.

now our resume is ready.
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CURRICULUM VITAE
FERSONAL INFORMATION
Full Nams Boda Rohit Ana
Gender Mzle
Phone 9388776655

Email ba:

Address . Patamata, V

CAREER OBIECTIVE

‘To make 3 50und position @ o and work towasds ity purspns

skills mdlm'-\]aﬂ? it devotin and hard '-ml.

EDUCATIONAL BACKGROTUND

B.COM - Bachelor of Commerce fromP R Colleze Ealinada Andhra University

MB A (Master of Business Administration) from Pondicherny University, Pondicherry with
specizlizatim of Mardketing

WORK EXFERIENCE
Warked 252 CS Traines in AsshesInfaTach Limitad Listad i BSE, NSE, D3E from Naw
Dealhi (X Jlan

w \'Iﬂ.éi in Zaty
(Tune ‘JLmFab ‘31;-
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2.3 Creating your class timetable.

Open a blank Word document
Type "B.Com Computer Applications" and press enter key then type "1st Semester - TIME TABLE"
Select text and increase font size to 16 by select size from HOME tab.

On the Insert tab, in the Tables group, click Table, and then click Draw Table by selecting 7 rows and
8 columns.

On first row, in the first cell type the value “Time" and type the values "09:00 - 10:00", "10:00 -
11:00", "11:00 - 12:00", "1:00 - 2:00", "2:00 -3:00" and "3:00 - 4:00" in respective cells in first row.

Now at second row first column cell type "Day" and then type days of the week "Monday",

"Tuesday", "Thursday", "Friday" and "Saturday" in respective column cells.

Select last two columns from 6th row by clicking the left edge of a cell and then dragging to the next
cell.

Under Table Tools, on the Layout tab, in the Merge group, click Merge Cells and then type
"Computer LAB"

Select last two columns from 7th row by clicking the left edge of a cell and then dragging to the next
cell.

Under Table Tools, on the Layout tab, in the Merge group, click Merge Cells and then type
"Computer LAB".

1 4 1 2 3 4 5 3 7 8 -

B. Com Computer Applications
11 Semester —- TIME TABLE

Time 9:00: - 10:00 10:00-11:00 11:00-12:00 1:00 - 2:00 2:00m- 3:00
Wonday Engheh Hectl Ery, Studies BO&EM Ses Lang
Tuesday BO&M English Computers HVFE Hectl
Wednesday Sec Lang Hectl BO&M Computers HVEPE
Thursday Computers SecLang English Acetl EO&M
Friday BO&M Computers Env. Studies Computer LAB
Saturday Computers Hectl English Computer LAB

bAGE10F1  60WORDS [[%

Now select the table. A Table Tools Design tab now appears on the Ribbon.

Select the Design tab to access all of the Table Styles and Options.
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Click through the various styles in the Table Styles section. Left-click a style to select it.

Document] - Ward TABLE TOOLS
IGN PAGE LAYOUT REFEREMCES MAILINGS REVIEW VIEW DESIGN LAYOUT

Y pt - S
Shading Border = Borders Border
- Styles~ w2 Pen Color~ +~  Painter

Borders ]
# [ T# 8 #

EEees 5000 BEETTT BEETTT ECTTT  EE Grid Tabled- Accent5 )

|_ S |_ [ |_ [ |_ P - -y - - e ———— .
B Modify Table Style... cations
[ Clear \BLE

i New Table Style...

Monday English Env. Studies Sec. Lang
Tuesday BO&M English Computers HVPE Acctl
Wednesday Sec. Lang Acctl BO&M Computers HVPE
Thursday Computers Sec.Lang English Acctl BO&M
Friday BO&M Computers Env. Studies Computer LAB
Saturday Computers Acctl English Computer LAB

The table style will appear in the document.

L i E 1 2 3 4 5 6 7 s A [+]
B. Com Computer Applications
1 Semester — TIME TABLE
\ Ll

b Monday English Acetl Env. Studies BO&M Sec. Lang

Tuesday BO&M English Computers HVPE Acetl
7 ‘Wednesday Sec. Lang Acctl BO&M Computers HVPE

Thursday Computers Seclang English Acetl BO&M
M Friday BO&M Computers Env. Studies Computer LAB

Saturday Computers Acctl English Computer LAB

PAGE1OF1 60WORDS [
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2.4 Perform mail merge using MS Word

e Open Microsoft Word

e Type the letter with all needed text and formatting leaving areas for the data source data
blank (name, address...)

e Click the Mailings tab

e C(Click Start Mail Merge

e Click Step by Step Mail Merge Wizard

tart Mail Select Edit H
Merge = |Recipients = Recipient List | Me

Letters

E-mail Messages 1
Envelopes...

Labels...

Directory

Mormal Word Document

AENDEDD

Step by Step Mail Merge Wizard...

The Mail Merge task pane appears on the right of your screen. Note there are 6 steps.

Mail Merge - X

Select document type

What type of document are you
working on?

) Letters
) E-mail messages
) Envelopes

) Labels

) Directory

Letters

Send letters to a group of
people. You can personalize the
letter that each person receives.

Click Mext to continue.

Step 1Lof 6
& MNext: Starting document

Step 1

e C(lick Letters for the document type



Information Technology 35

Practical Manual

e C(Click Next: Starting document

Step 2

e Click Use the current document under Select starting document

e C(Click Next: Select recipients

Step 3

The recipients can come from either an existing Excel file, or Access table or youcan create a new

list.
e If Using an Existing List:
1) Click Use an existing list under Select recipients
2) Click Browse
3) Select the file

4) Click Open

Mail Merge Recipients opens showing the name, city and mails from your file

Mail Merge Recipients

checkboxes to add or remave recipients from the merge. When your listis ready, dick OK.

+ I

This is the list of recipients that will be used in your merge. Use the options below to add to or change your list. Use the

Data Source [ |Name - | City w | Email Address

developers.mdb Srinivas | Chennai

developers.mdhb [V Surya Hyderabad
developers.mdhb [ Shourya Visakhapatnam shouryadprog@yahoo...
developers.mdb [¥  RohiArya Guntur

surya.cse@yahoo.couin

Arya.code@gmail.com

| srinivas.tech@gmail.co...

Data Source Refine redipient list

developers.mdb ‘-} ,L Sort...

7 Filter...
&3 Find duplicates. ..
27 Find redpient...

J Validate addresses...

5) Click OK
6) Click Next: Write your letter

e To Type a New List:

1) Click Type a new list under Select recipients
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2) Click Create

3) Click Customize Columns to modify the list of fields

Type redpient information in the table. To add more entries, dick Mew Entry.

Title vIFrstNa’ne w | Last Name w | Compary Mame w | Address Line 1 w
11 1 ]

Field Mames

A
First Marme

Last Mame
Company MName
Address Line 1
Address Line 2
City

State

7IP Code

Country or Region
Home Phone
Work Phone
E-mail Address

4) Delete any unnecessary field names and/or add new ones
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Mew Address List ?
Type recdpient information in the table. To add more entries, didk New Entry.,
Name - | City - | E-mail Address -
Srinivas Chennai srinivas.tech@gmail.com
| |Surya Hyderabad surya.cse@yahoo.co.in
Shourya Visakhapatnam  shouryadprog@yahoo...
Rehi Arya Guntur Arya.code@gmail.com
New Entry Find...
Delete Entry Customize Columns... oK Cancel
5) Click OK

6) Type records here hitting TAB to advance to the next field and to continue adding new
records

7) Click OK
8) Click Save

The recipients list will be saved as a separate file as a Microsoft Access file type. It is saved in
the My Data Sources folder. It is recommended to save the file in this folder.

9) Click Next: Write your letter
Step 4

e C(lick the location in your document where the data from the mail merge fields need to be
inserted

e Click Address block...

e Select the address elements you want included

e Click OK
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2
Insert Address Block :
Spedfy address elements Preview
Insert redpient's name in this format: Here is & preview from your recipient list:
Josh ~ 3 [ [
Josh Randall Ir.
ig:lﬁuﬁ;. Randall Ir. Shourya
Joshua Randall r. Visakhapatnam -
Joshua Q. Randall Ir. M

| Insert company name

Insert postal address:

Mewver indude the country fregion in the address

Always indude the countryfregion in the address
) T Correct Problems
® Only indude the countryfregion if different than:
If items in your address block are missing or out of order, use

India Match Figlds to identify the correct address elements from your
mailing list.
| F t add ding to the destinati tr i
ormat address according e destination countryregion Match Fields. .
oK Cancel

The field name will look like this: <<AddressBlock>>

The Address block will insert the following fields including any necessary punctuation: Name, city

and email address.

= =P Rules -
585 H |y} .
v Match Fields

|Inser‘t Merge
Field = Indate Labels

! Mame
City O
Email_Address

If your fields do not match the ones listed above or you have additional fields, click More items...

e Click on the field from the list
e Click Insert
e C(lick Close

The field name will look like this - «Name». Repeat this step until all fields have been
inserted. Remember to put spaces and punctuation where needed.
e  Click Next: Preview your letters
Step 5
Here is where we can preview the first page with the fields filled in.
e  Click Next: Complete the merge

Step 6
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To Complete the Merge:

e  Click Print to send directly to the printer
o Click Edit individual letters to create a new file

Remember to save your document as you go. The next time you open your document and click on
Step by Step Mail Merge, the data file will be attached.

6.7.2 Creating Labels

e Open anew blank document

e C(Click the Mailings tab

e Click Start Mail Merge

e Click Step by Step Mail Merge Wizard

e Click Labels for the document type
e C(Click Next: Starting document

e C(Click Label options under Change document layout
e Choose the label style you are using

e C(Click OK

e C(Click Next: Select recipients

Label Options ?

Printer information

() Continuous-feed printers

(®) Page printers Tray: |Default tray (Automatically Select) | w
Label information

Label vendors: | Microsoft v

Find updates on Office.com

Product number: Label information

a | Type: 1/2 Letter Postcard
L’:ﬁ et Height: 2159 cm

1."'4 Letter Width: 13.97 cm

30 Per Page Page size: 27.94an = 21.59 am
30 Per Page bd

Details... MNew Label. .. Cancel

e C(Click Use an existing list under Select recipients

e Click Browse

e Select the file that contains the names and addresses
e C(Click OK



Centre for Distance Education 40 Acharya Nagarjuna University

e C(Click Next: Arrange your labels

Step 4

e C(lick in the first label box and click on either Address block or More items to insert the data
fields

e C(Click Update all labels to include the fields on all labels

e  Click Next: Preview your labels

Step 5

Here is where you can preview the labels.
e Click Next: Complete the merge

Step 6

e Click Print to send directly to the printer or we can create a new file by click on the Edit
individual labels.
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3. MS EXCEL

3.1 MS Excel performing different formulas

When working on a spreadsheet, we will almost definitely need to perform some calculations on the

data you have.

The first thing you need to remember about Excel calculations is that formulas always start with an

=sign.

Let us begin with a very simple calculation. Type “=3+5" into cell A5 as shown below.

X d |= Book1 - Microsoft Excel
m Home Insert Page Layout Farmulas Data Review Wiew
== Cut — .
J & M TAN T==# N
53 Copy ™ . :
raste B I U === &5 8 - o » | %0
Clipboard Font Alignment MNumber

LARGE - K v | =345

A B C D E G H | 1 K

Sunday Monday Tuesday Wednesday Thursday Friday Saturday Sunday Monday Tuesday Wednesday

-

1
2
3
4
5
]
7
8

200

9 4.00
10 17-Aug

11

12

13

14

Press Enter. Excel automatically replaces the formula with the result of the equation.

Now let us calculate the sum of the numbers in I8 and 19. In cell J10, type “=I8+19”.

One other option is to type in “=", then select cell I8. After that, type in “+” and then select 19.
Pressing Enter will give you the result of the calculation.

Double-clicking on the cell with the formula allows you to edit the formula.

Excel has built-in functions that make your life easier. One of them is the SUM function. In cell J11,

type “=sum(“. Now select both cells 18 and I9.
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(]l 7 ~ = Book1 - Microsoft Exce
m Home Insert Page Layout Formulas Data Review View
$ Cut " — .
& M AN | T==|%® M
=3 Copy ~ .
B L U-|i \ - E == |EE H - % s | %850
Clipboard Font Alignment MNumber

LARGE = K v & | =189

B B C D E G H | ] K

Sunday Monday Tuesday Wednesday Thursday Friday Saturday Sunday Monday Tuesday Wednesday

-

1
2
3
4
5
6
7
3
9 L a0
10| 17-Aug i=|s+|9 ]

11
12

Pressing Enter gives you the same result as the plus operation we did in cell J10.

Try changing the value in cell 18 and notice how the change is reflected in both formulas
Now,

Open Sheet 2 in your workbook.

In cells A1 and A2, type 1000 and 1500 respectively.

Use auto-complete to fill in cells A3 to A8.

Format the numbers so that they show the 1000 separator (1,000) and have one decimal place.
Calculate the following values for cells A1 to A8 using built-in Excel functions:

a) Sum =sum(A1:A8)

b) Maximum =max(A1:A8)

¢) Minimum | =min((A1:A8)

d) Average =average(A1:A8)

e) Median =median(A1:A8)

f) Standard deviation  =stddev(A1:A8)
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X9~ %
Home Insert Fage Layout Formulas
= b Cut Calibri S AT A
P‘ : 53 Copy - A A
aste o i =
- - Format Painter B 1 1 : S
Clipboard Fa Font
D7 v | f | =STDEV(A1:A8)
A B C (B] E

1000
1500 22000

1

2

3 2000 2750

a 2500 4500

5 3000 1000

6 3500 2750
7| 4000 [224.7a3]

8 4500
9

]
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3.2: Creating charts in Excel.

The ABC Company shows the sales of different products for 5 years. Create column chart for
the following data

YEAR PRODUCT-1 PRODUCT-2 PRODUCT-3 PRODUCT-4
2003 1000 800 900 1000
2004 800 80 500 900
2005 1200 190 400 800
2006 400 200 300 1000
2007 1800 400 400 1200

1. The first step in creating a bar graph is to enter the data into the worksheet.

2. Enter data in columns i.e. enter 5 years product information in cells from Al through E6.

Note: Be sure to select any column and row titles that you want included in the graph

3. Click on the Chart Wizard icon on the standard toolbar

9 = -4l 4[] o - o]

i Gn 0| EE EE .
| & | H [ o [ 4 [ K

Or select “chart” option from the “insert” menu.

4. It displays a dialog box "Chart Wizard - Step 1 of 4 - Chart Type".
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Chart Wizard - Step 1 of 4 - Chart Type

Standard Types | Cuskom Twpes

Chart bype:
1ol EEE ~ |
E Bar

@ Line

» Pie

. WY (Scatter)
n Area

D> Doughnuk
@ Radar

@ Surface

oy Eubble “

Chart sub-type;

ihi
|

Clustered column with & 3-D visual effect,

[ Press and Hold bo Wiew Sample

Cancel

Mexk =

J

Einish

]

7. Click "Next" button.

5. Choose the "Column" chart type in the left hand pane.

8. It displays a dialog box "Chart Wizard - Step 2 of 4 - Chart Source Data".

6. Choose the "Clustered Column with a 3-D visual effect" chart sub-type in the right hand pane.
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Source Data

Drata Fange Series
1800
1600
1400
1200 o Series]
1000 7 B Seriesd
00 I O Series
GO0+ O Sericsd)
400 -+ B Eeriesh|
200 471
|4
PRODUCT-1 PRODUCT-2 PRODUCT-3 PRODUCT-4
Datarange: | =sheet114B42:4E47
Series in: (%) Riows
() Columns
[ Zancel ] [ < Back ” Mext = ] [ Finish

9. Click in the Chart data range box

Chart Wizard - Step 2 of 4 - Chart Source Data - Datar... @
.

=Sheet11$B$2:4E47

Then select the range ie B2 through E7 on the worksheet. The Collapse Dialog button at the right
end of this box temporarily minimizes and moves the dialog box so that you can select cells on the
worksheet. To return to the entire dialog box, click this button again after you select the range.

10. Click on “Series” Tab. It lists existing data series names. We can add and remove data series from
the chart without affecting the data on our worksheet.
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Chart Wizard - Step 2 of 4 - Chart Source Data

DataRange | Seties
1300
1600
1400
1200 w2005
1000 — m 2004
00 o 2005
600 O Serics |
400 W Series))
200
Es
PRODUCTA PRODUCT-2 PRODUCT-3 PRODUCT-4
Series
2003 Mame: ="2005" £
2004 | .
Seriesd 2
Seriess Yalues: | =Sheet114B45:$E45 _
Category (%) axis labels: |=Sheetl 1§E$2:5ES2
[ Cancel ] [ < Back H Mext = ] [ Einish ]

11. Click "Next" button.

12. It displays a dialog box "Chart Wizard - Step 3 of 4 - Chart Options".

Chart Wizard - Step 3 of 4 - Chart Options

Titles | Axes aridines | Legend || Data Labels | Data Table
Chart title:
|.C\BC company | ABC company
Category (%) axis; 1500
1600
|F'ru:uduct | 1400
1200
1000
| | Fales s00
800
Yalue (Z) axis: ;gg
|5ales | a
PRODU PRODU PRODU PRODU
cT4 CT-2  CT-3  CT-4
Product

Cancel H < Back ” Text = ][ Finish

13. Click on the ‘Titles” tab at the top of the dialog box.

14. Click in a “Chart Title” box, and then type the text ABC Company. Similarly enter text Product and
Sales for “Category(X) axis:” and “Value(Z) axis:” boxes respectively.
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Chart Wizard - Step 3 of 4 - Chart Options

Titles Axes aridiines Data Labels | Data Table
+| Show legend
- : g ABC company
acemen
1800
(*) Bottom o
O Carner {200
1000
O IUP Sales a00
600
© ek %
() Left 0

FROOU PRODU PRODU  PRODU
cT-1 CcT-2 CT-3 CT-4
Product

O 2003 20040 20050 20068 EDU?I

Cancel H < Back, ” Mext = ][ Finish

15. Click on “Legend” tab. check the box “Show legend” to add legend to box to our chart area and
click on “Bottom” radio button to places the legend at bottom of the chart area.

16. Click on “Data Labels” tab.

Chart Wizard - Step 3 of 4 - Chart Options

Titles Axes aridines | Legend | Data Labels |Data Table

Label Contains

[] zeries name ABC company

|:| Cakegory name

Zales
Separator: PRODU FROCU PROCU PRODU
T4 CT-2 CT-5 CT-4
Product
[ Legend key
0 20070 20040 20050 20068 2007
Cancel ] [ < Back ” Mext = ] [ Finish

17. Check “Value” under “Label contains” group to displays the value represented for all data points.

18. Click on “Next” button.
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19. It displays a dialog box "Chart Wizard - Step 4 of 4 - Chart Location".

Chart Wizard - Step 4 of 4 - Chart Location

Place chart:

all () As new sheet: |Prou:|uu:t Sales Chart |

i

ull (3 as object in: |ShEEt1 W |

E—=,

B

[ Zancel J[ < Back J Mext =

20. Click “As new sheet”, and then type a name for the new chart sheet in the “As new sheet” box to
place the chart on a new chart sheet.

21. Click on “Finish” button.

[ Microsoft Excel - stude info
9] Fle Edit Yew Insert Format Tools chart Windew Help Typeaquestionforhelp v o & X

§ Chart area BT HEIENEIRTRES

Chart Area = ~

ABC company

PRODUCT-1 PRODUCT-2 PRODUCT-3 PRODUCT-4
Product

[22003 m2004 02005 2006 m2007 |
.

0
1 4 » n)\Product Sales Chart { Sheetl { Sheet2 { Sheet3 1%
Ready HUM

i untiied - Paint.
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3.3 Printing and adjusting MS Excel worksheet

To view the spread sheet in Print Preview
e Left-click the Microsoft Office button.

e Select Print.

e Select Print Preview. The spreadsheet will appear in Print Preview view.

E_ii = T R ex07_
|

Preview and print the document
Mew ‘

Print
Select a printer, number of copies, and

Open other printing options before printing,

_ @ Quick Print !
Send the workbook directly to the default

Save ) ) .
printer without making changes.
Print Preview

Save As b . Preview and make changes to pages before
printing.

Print L4

Prepare F

N@PALT LD

Click the Close Print Preview buttonEto return to the Normal View.

Ot - 0 - 3 )5 ex07 Budget lesson?

Print Freview 1

i A ';g _§ Next Page

# |5 5

o L U Previoie: Page ?E _ _ o
Print  Page  Zoom Closeprint 2. Pravides you with the same print dialog box you

4 B Show Margins -
2 5'“:‘," Eeee can access from the Microsoft Office Button.
Print Zoom Preview

1. Tab indicates you are in Print Preview mode.

3. From here you can access many of the same
options that are available from the Ribbon, such as
Page Orientation and Scaling.

4. Toggles between zooming in and out of the
spreadshest.

5. Use these commands to move hetween the
pages.

6. Wiew and edit margin markers.

7. Close current wiew and return to spreadshest.

8. Indicates number of pages and which page you
are currently viewing.

HPreview: Page 1 af 2
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To modify margins, column width, or row height while in Print Preview:

e Click the Print Preview command on the Quick Access toolbar, or select Print
Preview from the Microsoft Office button menu. The spreadsheet opens in Print
Preview mode.

e Hover your cursor over one of theblack margin markers until adouble
arrow appears.

& DA

S

g |oet= JPaid Bl D
{Fimed Exp

Rant =/1/z00E] 33000 238000
Car =/ 13z008] 10100 210100
Car Paym ent B Bl
iHaalth | nsurance: B | B
iCabbe =/zs/z00s] fznm|  f3am

e Left-click and drag the marker to the desired location. The change will be reflected
in the spreadsheet.

To modify margins:

e Select the Page Layout tab.
e Left-click the Margins command.

e Choose one of the pre-defined settings, or enter custom margins.

oy
—‘j Home Insert Page Layout Farmulas Data I

Colors ~ 3 e 5
S T (3 5 (3 5
Fonts* -
Themes Margins| Orientation  Size Print Breaks Backg
- [C]Effects - - - +  Areaw -
Themes Mormal
Top: 0.75" Bottom: 0.75"
I A32 Left: 0.7 Right. 0.7"
A r-[:} Heacler: 0.3" Footer: 0.3" E
Wide
1 Top: 1" Bottom: 17
Laft: 1" Right: 17
2 I Header: 0.57 Faoter: 0.57
3
4 Marrow
Tap: 0.75" Bottom: 0.757
3 Left: 0.25" Right:  0.25"
6 | Header: 0,37 Faoter: 0,37
7 Bills Custom Mardi us
= = | ustom Margins...
8 Fixed Expenses
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To change page orientation:

e Select the Page Layout tab.
e Left-click the Orientation command.

e Select either Portrait or Landscape.

[* |
—-/I Home Insert Page Layout Formulas

ins |Orientation| Size Print
- [O]effects ~ - | "= Area-
Themes Getup

F — Portrait ]
A32 - ; [ y Job

A D
= Landscape

1

Portrait orients the page vertically, while Landscape orients the page horizontally.

To use Scale to Fit:

e Select the Page Layout tab.
e Locate the Scale to Fit group.

e Enter a specific height and width, or use the percentage field to decrease the
spreadsheet by a specific percent.

Scale to Fit is a useful feature that can help you format spreadsheets to fit on a page. However, be
careful with how small you scale the information—it can become difficult to read!

To change the paper size:

e Select the Page Layout tab.
e Click the Size command.
e Select a size option from the list.

To define a print area:

e Left-click, then drag your mouse to select the cells you wish to print.
e Click the Print Area command.

e Choose Set Print Area.
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-
— Home Insert Page Layout Formulas [Data Reviev

B == ] 3 GlaE @

Themes Margins Crientation Size Print |Breaks Backgrourm
- [O]Effects ~ - - - larea=| -
Themes Fag \$ . Set Print Area
A37 - J | Prims %IearPrintArea

e Now, only the selected cells will print. You can confirm this by viewing the
spreadsheet in Print Preview.

To return to the default setting, which is the entire worksheet, click the Print Area command, then
select Clear Print Area.

To insert a break:

e Select a cell below where you want the break to appear.
e Select the Breaks command.
e Select Insert Break.

Click Print Preview to confirm that the break appears in the correct place in your spreadsheet.

To print from the Microsoft Office button:

e Left-click the Microsoft Office button.

e Select Print —* Print. The Print dialog box appears.

.-E'_S'“: | &)= ex07
|

Preview and print the document

Print
L\\g Select a printer, number of copies, and

Open other printing options before printing,

®  Quick Print
Send the workbook directly to the default
printer without making changes.

E= I Print Preview
H save As b ﬁ Preview and make changes to pages before

Save

printing.

Print 4

e Select a printer if you wish to use a printer other than the default setting.
e Click Properties to change any necessary settings.

e Choose whether you want to print specific pages, all of the worksheet, a selected
area, the active sheet, or the entire workbook.
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e Select the number of copies you'd like to print.
e Click OK.
You can select Quick Print to bypass the Print dialog box.

4. Prepare a worksheet for calculating percentages of your class mates using different excel
formulas.
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3.4 Prepare a worksheet for calculating percentages of your class mates
using different excel formulas

1. Click on cell A2.

2. Type the text “Roll No”. Press the Tab key on your keyboard The darker border will jump
right one cell to B2

3. Type “Name” and then press the Tab key. The darker border will jump right one cell to
C2

4. Type “Maths” and then press the Tab key. The darker border will jump right one cell to
D2

5. Type “Physics” and then press the Tab key. The darker border will jump right one cell to
E2

6. Type “Computers” and then press the Tab key. The darker border will jump right one cell
to F2

7. Type “Total” and then press the Tab key. The darker border will jump right one cell to G2

8. Type “Average” and then press the Tab key. The darker border will jump right one cell to
H2

9. Type “Result” and then press the Tab key. The darker border will jump right one cell to
12

10. Type “Grade” and then press the Enter key. The darker border will jump down one cell to
A3

11. Select cells A2 through 12 and press “Bold” icon in formatting toolbar.

12. Select cells Al through I1 and click on “Merge and Center” icon and then type “B.Com
Result Sheet”.

13. Click on cell A3.

14. Type “NT1001” and then press the Tab key. The darker border will jump right one cell to
B3.

15. Type “Swathi” and then press the Tab key. The darker border will jump right one cell to
Cs3.

16. Type “86” and then press the Tab key. The darker border will jump right one cell to D3.

17. Type “76” and then press the Tab key. The darker border will jump right one cell to E3.

18. Type “37” and then press the Tab key. The darker border will jump right one cell to F3.

19. Similarly enter data for remaining students as next rows.
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20.
21.
22.
23.
24,

25.

26.
27.
28.
29.

30.
31.

32.

33.
34.
35.
36.
37.

38.

39.

40.
41.

42.
43.

Click on cell F3.

Now click inside the formula bar

Type in this: =sum(C2:E3) and press Enter key.

It displays 199. Move the cursor over fill handler of the cell.

When we see the black cross, hold down left mouse button, keep it held down, and then
drag your mouse across to cell F9.

When your cursor reaches cell F9, let go of left mouse button. Excel will Auto Fill the
formula from cell F3.

Click on cell G3.

Now click inside the formula bar

Type in this: =F3/3 and press Enter key.

It displays 66.3333. Click on “decrease decimal” icon in formatting toolbar twice to set
no. of decimal points as 2.

Move the cursor over fill handler of the cell.

When we see the black cross, hold down left mouse button, keep it held down, and then
drag your mouse across to cell G9.

When your cursor reaches cell G9, let go of left mouse button. Excel will Auto Fill the
formula from cell G3.

Click on cell H3.

Now click inside the formula bar

Type in this: =IF(AND(C3>=35,D3>=35,E3>=35),"'Pass"",""Fail") and press Enter key.
It displays Pass. Move the cursor over fill handler of the cell.

When we see the black cross, hold down left mouse button, keep it held down, and then
drag your mouse across to cell H9.

When your cursor reaches cell H9, let go of left mouse button. Excel Auto Fills the
formula from cell H3.

Click on cell 13.

Now click inside the formula bar

Type in this: =IF(H3="Pass", IF(G3>=75,"Distinction" IF(G3>=60,"First Class",
IF(G3>=50,"Second Class", IF(G3>=35,"Third Class')))),""No Grade') and press
Enter key.

It displays “First Class”. Move the cursor over fill handler of the cell.

When we see the black cross, hold down left mouse button, keep it held down, and then
drag your mouse across to cell 19.
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44. When your cursor reaches cell 19, let go of left mouse button. Excel Auto Fills the

formula from cell 13.

45. After completing enter database, the worksheet looks like as in the image below

e R I T
LG 3 i da FRIL OB Fa-r 8L -Jlil Q4w 8

™ 10 2 B E RS % a0 e

Ge = O
A B & | o | E | F [ & | H | I [ 4 =

1 B. Com Result Sheet

2 Rollne  Hame Maths Physics Computes Total  Average Result  Grade

3 MT1001  Amrutha a6 Th 55 217 72.33 Pass First Class

4 MT1002 Apparas 30 56 43 184 61.33 Fail Ha Grade

5 MT1003  Kiran Kurnar a3 a3 &0 2 90.33 Pass Distinction

& MT1004 Siva Rama Krishna a7 4 78 189 85,33 Pass First Class

7 |MT1005 Srinivasarao 44 El| 59 14 44 87 Fail Ho Grade

& MTI1006 Swathi T4 43 56 178 59.33 Pass Secomd Class

9 MTI007 ‘\enkateswars Rag 58 58 3 154 51.33 Pass Second Class

10

1"

12

13
14 1
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4, MS Power Point.

4.1 Create presentation in power point
1. Start Microsoft PowerPoint presentation
2. Start a new blank presentation
3. Your first Slide is going to be a Title Slide
4. Write the Text as in the preview below:SriShourya Co Ltd
5. Make the Font of “Lighthouse” Arial Black and size 88
6. Insert a second slide this should be with a layout of Bulleted List
7. Write the Text as in preview below
a. [Title]: Lighthouse Co Ltd
b. [Body]:
i. Mission Statement
ii. Company Objectives
iii. Management Team
iv. Employees
v. Sales

8. Make the Font Colour of the Points to Green
9. Insert a third slide this should be an Organization Chart. Include the following people in the
chart:
a. Srinivasa Rao, General Manager
b. Lakshmi Shourya, Head of Sales
c. Rohit Arya, Assistant to the General Manager
d. Kameswari, Human Resources Manager
10. Add a fourth slide this should be a Table Chart. The chart should look like the following:

11.

12. The Fifth slide should be a Chart slide. The chart should be a bar chart, and include the

Make the titles New Products and Discontinued Products with a shadow effect and centred

New Products

Discontinued Products

Digital Camera

8mm Cameras

Ultra Slim Video Camera

8x Zoom Video Cameras

25” Plasma TV

21”Black and White TVs

DVD Recorders

Video Players

7.1 Dolby Surround Systems

2 channel stereo systems

in the cell. Widen columns to fit Text as above.

following data must be used to form the chart:

January | February | March | April
TVs 20 27 90 75
DVDs 30 38 34 31
Hifi equipment 45 46 45 43
Video Recorders | 25 29 15 40
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JanuaryFebruaryMarchAprilTVs20279075DVDs30383431Hifi equipment45464543Video
Recorders25291540

13. Change the colours of the chart so that the series of bars are red, yellow, pink, and green.

14. Add a light coloured background to all slides in the presentation.

15. Add also Transition effects between each slides and also different effects for all text and
pictures it the presentation.

16. Reverse the order of the second and third slides

17. Save the presentation as Surya House Ltd
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4.2 Inserting, deleting slides in Power Point

Insert a new slide

= Select the slide you want your new slide to follow.
= Select Home > New Slide.

= Select a layout.

= Select the text box and type.

— :|La}rout'
D EEZ| Reset
Paste Mew T
- Slide = ESEctiDn'
Clipboard Slides
Delete slides

1. For a single slide: Right-click the slide in the thumbnail pane on the left, and
select Delete Slide.

2. For multiple slides: Press and hold Ctrl, and in the thumbnail pane on the left, select
the slides. Release the Ctrl key. Then right-click the selection and choose Delete

Slide.

3. For a sequence of slides: Press and hold Shift, and in the thumbnail pane on the left,
select the first and last slides in the sequence. Release the Shift key. Then right-click
the selection and choose Delete Slide.



Information Technology 61 Practical Manual

4.3  lllustrate Animation in presentation

PowerPoint animation is a form of animation which uses Microsoft PowerPoint and similar programs
to create a game or movie. The artwork is generally created using PowerPoint's AutoShape features,
and then animated slide-by-slide or by using Custom Animation.

e To apply a default animation effect:
o Select the text or object on the slide you want to animate.
o Select the Animations tab.
o Click the Animate drop-down menu in the Animations group to see the animation

(0]

(0]

options for the selection. The options change based on the selected item.

AnE "9-0
i

Home Insert

Eghnimate: Mo Animation |= || |
; _ — p—
Preview =§_E| Custom A Mo Animation
Fade %
Wipe

Fly In
Custom Animation...

Move your cursor over each option to see a live preview of the animation on the
slide.
Click an option to select it.

e To apply a custom animation effect:

O
O
O

o

Select the text or object on the slide you want to animate.

Select the Animations tab.

Click Custom Animation in the Animations group. The Custom Animation task pane
will appear on the right.

"Ll | BY9-0 = pRO7_CompanyOver,
i

Home Insert Design Animations

Eg_ﬂ Custom Animation

Click Add Effect in the task pane to add an animation effect to the selected text or
object.
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ot lng Design Skse Show  REdew  View Adadns -
— r WMo Sound - || Adwance Shde
L. [o] Rnimate: | Mo Asunation -] l . /== =
- A - Itk | - | -J l _-j -Jl - Fant - [¥] on Mouse cick
Preveens | [y Custom Animation] — -

—! vl Aty To [ Automatscaly Atter: [0000 2 |

Vision
To generate sources
of knowledge that e i e o it Lo
dispel ignorance and ° /
establish truth through
teaching, learning and
research.

Click to add notes

o Select Entrance, Emphasis, Exit, or Motion Path to display a submenu of animation
effects for the category.

|5 AddEffect v| % Renove

Salact an afamant af tha slick, fhan

More Effects...
ok Ao Effect” fo ads’ animatian.

& 1. Elinds S Entrance 3

r 2. Box 3% Emphasis %h |
Z 3. Checkerboard oo Exit 3 |
& 4. Diamond <=  Motion Paths » |
# 5 FyIn ‘

Entrance: Changes how the selected item appears on the page

Emphasis: Draws attention to the selected item while the slide is displayed

Exit: Changes the way the selected item disappears from the slide

Motion Path: Animates the selected item so it moves to a specific place on the screen

o Select an animation effect to apply it.

o The animation will display on the selected item on the slide and will appear listed in
the Custom Animation task pane.
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i e P

Modify: Blinds
Raet: 3 On Cik =

Dwection Horzontal v

Vision Speed: Very Fast v

To generate sources ; e o [ 13 3% Corvent Placeholde... ¥ |
of knowledge that 3

dispel ignorance and

establish truth through

teaching, learning and

research. 7§

’ Click to add notes

o A number label appears on the slide next to the animated object. A matching
number label also appears next to the animation in the Custom Animation task pane
list.

o Drop-down menus appear at the top of the Custom Animation task pane. You can
define the animation effect in greater detail here.

o The star Play Animations icon appears beneath the slide on the Slides tab in the task
pane on the left. It indicates that the slide has an animation effect.

o Select More Effects or More Motions Paths from the menu to see more animation
effect options.

To modify a default or custom animation effect:
o After you apply an animation effect, drop-down menus will appear at the top of the
Custom Animation task pane. The menus vary based on the animation effect.
o Select an option from a drop-down menu to change the default setting.

’5}% Change 'l [K_ﬁ Remove]

Muodify: Blinds
Start: B on click vl|
Direction: Horizankal F |

Speed: v Horizontal | ~
Il“a Vertical _vl

o Repeat until all menu options are at desired settings.

To remove an animation effect:
o Select the text or object on the slide you want to modify.
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o Select the Animations tab.

o Click Custom Animation in the Animations group. The Custom Animation task pane
will appear on the right.

o Select the animation in the Custom Animation task pane list, if it is not already
selected.

o Click Remove. The animation label will disappear from the slide and from the
Custom Animation task pane list.

Custom Animation v X
[;ﬂf{ Change v] Ix_-;; F‘\Emcma[bS
Modify: Blinds

Start: “B on Click >
Direction: Verkical

Speed: Fast

[ 1“5 3k Content Flaceholde... v |

e To apply a different animation effect:

o Select the text or object on the slide you want to modify.

o Select the Animations tab.

o Click Custom Animation in the Animations group. The Custom Animation task pane

will appear on the right.

o Select the animation in the Custom Animation task pane, if it is not already selected.
Click Change.
o Select an Entrance, Emphasis, Exit, or Motion Path animation effect.

o

I T | Custom Animation v x
[:ﬁ& Change v] [K_ﬁ Remove

3 1 Blinds Sk Entrance v

H 2 Box F=  Emphasis ¥ 5 click

# 3. Checkerboard P Exit (s

# 4. Diamond <% Motion Paths »

# sFyhn % A _

- I 13 3k Content Placeholde... »

- Maore Effects...

o New drop-down menus with default settings will appear at the top of the Custom
Animation task pane.
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Custom Animation X

[;ﬁ hange v] [K_ﬁ Remove

Modify: Diamond

Skart: “B on Click v
Direckion: In

Speed: Medium

[ 1“3 3% Content Placshalde... »

Custom Animation v .

e To preview an animation effect:

@)

Select the text or object you want to modify on
the slide.
Select the Animations tab.
Click Custom Animation in the Animations group.
The Custom Animation task pane will appear on
the right.
Select the animation in the Custom Animation task
pane list.
Click Play at the bottom of the task pane to see
a preview of the animation in Normal view.

OR
Click Slide Show to see the animationin Slide
Show view. Press the Esc key to return to Normal
view.

To animate text with a default animation:

O

[Zﬁ% Change v] [K_{,} Remnve]

Modify: Diamond

Skark: “B on Click -
Direckion: In P
Speed: Medium ~

| 1“3 S Content Placsho... ~ |

- b

[P— Play ] [E Slide Showe ]

AutaPrewview

Select the text box or text you want to animate on the slide.

Select the Animations tab.

Click the Animate drop-down menu in the Animations group to see the animation
effects for the selected text. The effects vary based on the selected item.

Select an animation effect.
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pp07_CompanyOvervi

Home Insert Design Animations

1.5 Animate: | All At Once |- ]

m Mo Animation s =

Mo Animation
Fade

All At Once

Ey 1st Level Para%raphs
Wipe

All At Onee

By 1st Level Paragraphs =
FlyIn ; |0

All At Once

By 1st Level Paragraphs

Custom TIDO‘.I'
Custom AniT?i_:ion... - me ||

All At Once: The selected text appears all at once. The entire text is labeled
with one number on the slide. Click the drop-down arrow in the task pane to
expand the contents and see that the text is labeled with one number.

B AddEffect = %

Modify effec

MissionStatement
G [ — o

+ To empower students to
become lifelong learners
o 3k Content Placeholder &
+ To provide an open

environment for learning N \ =3 d 10 3 Cortent Placeholder...

&

+ To help students acquire g
the computer skills they
need to succeed in the
213 century

By 1st Level Paragraphs: The text will appear bullet by bullet, or paragraph
by paragraph. Each level of text is labeled with a different number on the
slide. Click the drop-down arrow in the task pane to expand the contents
and see that the text is labeled with multiple numbers.

Mission,Statement

O g O
17 Toempdwer students to

become lifelong leamers
0 S Content Placeholder &

2 |+ To provide an open -
environment for learning 13 ¥ Content Placeholder...

Click to expand contents

3.7 » To help students acquire [1
| the computer skills they

need to succeed in the

21% century

o To modify an animation effect in other ways:
o Select an animation effect in the Custom Animation task pane list.
o Click the arrow to display a drop-down menu.
o Select Effects Options or Timing. A dialog box will appear.
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O

In the dialog box, add enhancements such as sounds, and define what happens after
the animation effect is applied to the selected item.

Effect | Timing | Text Animation

Enhancements

Sound: {Ma Sound]

=

After animation: | Don't Dim

Animate bext: &ll at once w

[ K l’ Cancel ]

O

The dialog box name is based on the animation effect name. In the example above,
the animation effect is Fade. The tabs and options on the tabs will vary based on the
animation effect that is being modified.

e To reorder animation effects.

O
O
O

Select the Animations tab.

Click Custom Animation in the Animations group.

Select the animation effect you want to move in the Custom Animation task pane
list.

Click the arrows at the bottom of the task pane to reorder the selected animation
effect.

Fe-Crder

[F Play ] ['E' Slide Show ]

AuUboPreview
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